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[bookmark: _Toc207097726]– INTRODUCTION 
A dissertation, thesis, or doctoral project is one of the most important pieces of work a student will accomplish during his or her graduate career. The quality of the document is a reflection of the student and The University of Southern Mississippi. Therefore, the Graduate School is committed to helping students produce the best document possible. 
[bookmark: _Toc207097727]Academic Integrity
The University’s Academic Integrity web page contains information for recognizing and avoiding academic misconduct. The most common act of misconduct is plagiarism, which occurs when a student fails to acknowledge the work of another scholar or presents another scholar’s work or idea as his or her own. The Graduate School will not tolerate plagiarism or any other academic misconduct; therefore, students have the responsibility of reviewing and following the University’s Academic Integrity Policy—link to policy is available through the Academic Integrity page. 
[bookmark: _Toc207097728]Style Guide
	Consult the dissertation, thesis, or doctoral project committee to determine which style guide to use for completing the document. Be aware the formatting requirements presented in these guidelines may supersede the formatting of certain style guides. 
[bookmark: _Toc207097729]Deadlines 
	The Graduate School has set deadlines to help students complete their document in a timely manner and to give the Documents Specialist time to review all submissions. Deadlines represent the last day to submit the required item to the Graduate School. 
Late completion of the requirements will result in a deferral of graduation to a future semester. For that reason, it is highly encouraged to consult the deadlines page frequently and to meet deadlines early. 
[bookmark: _Toc207097730]Citation Management
Citation Management Software is a useful tool for compiling sources and forming a bibliography. Visit the University Libraries web page for more information regarding citation management options. 
[bookmark: _Toc207097731][bookmark: Microsoft_Office_Suite]Microsoft Office Suite
Microsoft Word is a requirement for using the Graduate School templates. Students are encouraged to save their file in more than one location, but should never edit their file outside of Microsoft Word, as this will corrupt the format. Students should utilize Word 2016 or a more recent version while working with the templates. Earlier versions of Word may not load some of the template features discussed in later chapters. The latest version of Microsoft Office is available for all active students. Visit the iTech website or call the iTech help desk (601.266.4357) for more information.
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[bookmark: _Toc207097732]–TEMPLATES AND CONTENT FORMAT
The Graduate School requires students to format their document into one of the templates prior to submitting to the Documents Specialist. It is recommended students download and practice using the template features before officially writing or formatting their document. While using the template, students should frequently save, make multiple copies of saved files, and backup files to a flash drive and/or an electronic medium such as Dropbox, OneDrive, etc. The Graduate School is not responsible for progress lost because of not saving or backing up files. 
[bookmark: _Toc207097733]Which Template to Use?
This section will provide a brief overview of which students might benefit from each of the templates; though, students are more than welcome to choose from any of the Word templates and find the one that best suits their needs. Visit the templates page to download and view the templates. 
Template 1
Mostly used by students in non-STEM fields (humanities, education, etc.). Features include:
· Four sublevel headings: 1st level, 2nd level, 3rd level, and 4th level. 
· Tables and figures labeled in numerical order (Table 1, Table 2, Table 3…). 
· Document order: Title Page, Copyright Page, Abstract, Acknowledgement, Dedication, Table of Contents, List of Tables, List of Illustrations, List of Abbreviations, Main Text, Appendix, and References. 
Note: Use Template 3 or Template 4 if a List of Schemes and/or List of Musical Examples is required. 


Template 2
Mostly used by Creative Writers or other fields completing a creative project that is different from a traditional dissertation, thesis, or doctoral project. 
Features include:
· Four sublevel headings: 1st level, 2nd level, 3rd level, and 4th level. 
· Figures labeled in numerical order (Figure 1, Figure 2, Figure 3…).
· Document order: Title Page, Copyright Page, Abstract, Acknowledgements, Dedication, Table of Contents, List of Illustrations, Introduction, Works Cited, and Main Text.
Note: List of Tables, List of Schemes, and List of Musical Examples are not included in this template. See other templates if these lists are required.
Template 3
	Mostly used by students in STEM fields.
Features include:  
· Four sublevel headings labeled sequentially by chapter and distinguished by subsections (1.1.1, 1.1.2, 1.1.3…2.1.1). For example, “1.1 First level Heading Title” “1.1.1 Second Level Heading Title”. Headings must appear in numerical order.
· Tables, figures, and schemes labeled sequentially by chapter. For example, the first table in the third chapter will be labeled “Table 3.1”. Figure and Table titles must appear in numerical order. 
· Document order: Title Page, Copyright Page, Abstract, Acknowledgement, Dedication, Table of Contents, List of Tables, List of Illustrations, List of Schemes, List of Abbreviations, Main Text, Appendix, and References


Template 4
	Mostly used by students in the School of Music. However, some students in scientific disciplines may find this template fulfills their needs. 
Features include:
· Four sublevel headings: 1st level, 2nd level, 3rd level, and 4th level. 
· Tables and figures labeled in numerical order (Table 1, Table 2, Table 3…). 
· Document order: Title Page, Copyright Page, Abstract, Acknowledgement, Dedication, Table of Contents, List of Tables, List of Illustrations, List of Schemes, List of Musical Examples, List of Abbreviations, Main Text, Appendix, and References. 
LaTeX
	Only students in the School of Mathematics and Natural Sciences have permission to use LaTeX. Students outside of the School of Mathematics and Natural Sciences should get permission from the School prior to using the LaTeX template. Students will need to provide the Documents Specialist with confirmation they have received permission from the School. 
[bookmark: _Toc207097734][bookmark: Layout_Requirements]Layout Requirements
Margins: 1” left, 1” right, 1” top, and 1” bottom. All text, tables, figures, etc. must fit within these margins.
Font: Text must not exceed 12 pt. Times New Roman. Endnotes, footnotes, table notes, figure notes, scheme notes, and musical example notes should not go below 8 pt. Times New Roman. Other fonts—Arial, Calibri, etc.—are not allowed. 
Spacing: Text must be double-spaced. Items such as block quotes, references, endnotes, footnotes, table notes, figure notes, scheme notes, and musical example notes can be single spaced if specified in the style manual approved by the committee. Spacing should be consistent between headings, paragraphs, tables, figures, etc. throughout the document.
Columns: Information in columns (such as on the list of abbreviations page), must use the built in columns feature. Never use tabs or the spacebar to enter information in columns. Columns can be applied by going to the “Layout” tab. Select columns, then the number of columns needed. First type some or all of your content, then go into the Page Setup tab, then select columns, then select the number of columns you would like to appear. To choose where a column break appears, place your cursor and select “Insert Column Break.” If this does not appear in your paragraph style options, you can type it into the search box at the top of the page.
No Widows or Orphans: The first line of a paragraph should not be the last line of a page, and the last line of a paragraph should not be the first line of a page. Headings should also not be the last line of a page. Space a heading down to the next page if it falls on the last line.
Indents: Press the “Tab” key to create an indent. Be consistent with the size of indents. It is recommended that paragraph indents not exceed 0.5”. 
Lists: When creating lists, always use Word’s built-in numbered or bullet-point list function (rather than using a tab, dash, or any other short-cut) to ensure accessibility and to ensure that lists are all created at the same indentation level. 
Page Numbers: Preliminary pages will be in lowercase Roman numerals beginning with “ii” on the Abstract. The title page and copyright page should not have a page number. The main text starting with the first page of the first chapter will use standard Arabic numerals beginning with “1.” The template will automatically number pages. The page numbers may need to be adjusted manually if there are issues with the automatic numbering. 
For landscaped pages, page numbers will need to be moved to the left-hand side and rotated in order to match with the portrait page numbers when printed. See Landscaped Pages for more details.
[bookmark: _Toc207097735]Paragraph Marks
Paragraph marks reveal hidden formatting symbols to indicate the placement of spaces, indents, and section breaks/page breaks. To activate the Paragraph Marks, click on the ¶ icon in the paragraph section of the Home tab. 
Common symbols include:
¶ = Hard Return (Any instance of pressing the Enter key) 
ˑ = Space (Any instance of pressing the Spacebar) 
→ = Tab (Any instance of pressing the Tab key) 
· = Soft Return (Any instance of pressing Shift + Enter)
Note that the Paragraph marks are different from the Paragraphs dialogue box.
[bookmark: _Toc207097736]Paragraph Marks
 To open the Paragraphs dialogue box, right-click (Ctrl+click for Mac), and select “Paragraph.”
[image: A screenshot of a computer

AI-generated content may be incorrect.]
This opens the “Paragraph” dialogue box’s “Indents and Spacing” tab:
[image: A screenshot of a computer

AI-generated content may be incorrect.]
where you can adjust the paragraph indentation by choosing a first-line indent, a hanging indent, and adjusting the indentation size: 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
This paragraphs box also allows you to adjust line spacing, setting paragraphs to 2.0 spaced 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
With 0pts extra space before or after the paragraphs. 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
If there is any text (figure/table notes, or footnotes, citations) that you want to single space, you can change double to single here in those sections. In the second tab of the Paragraphs box, titled “Line and Page Breaks,” you will see the following options: 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
Select the box next to “Widow/orphan control” so that your document does not violate the “no widows or orphans” rule (found in layout requirements). This will stay on and apply to the entire document. For footnotes, table/figure titles, and table/figure notes, select the “keep with next” and “keep lines together” rules so they don’t break across pages. These two rules have to be applied individually to selected text. 
[bookmark: Section_Breaks][bookmark: _Toc207097737]Section Breaks
The templates have “section break (next page)” inserted to divide the document into multiple sections. When turning on the paragraph marks, the existing section breaks will become visible. 
	There are times when a section break will need to be inserted, such as when doing a landscaped page or inserting an additional chapter. 
To add a section break:
1. Place the cursor on the page or area the section break will be placed. 
2. Go to “Layout” or “Page Layout” on the toolbar and click on “Breaks.” 
3. Select “Next Page.” 
[image: A screenshot of a computer

Description automatically generated]
4. Turn on the paragraph marks to confirm the break has been inserted.
[image: A close up of a text

Description automatically generated]
[bookmark: _Toc207097738][bookmark: Navigation_Pane]Navigation Pane and Ruler
Enabling the navigation pane displays certain headings, chapters, and sections to allow quick navigation of the document. The navigation pane will appear on the left side of the document when enabled. Headings with the 2nd level, 3rd level, or 4th level heading style may not display in the navigation pane. 
Ensure that all headings appear in the navigation pane of your document, and that they match the visual outline of your document. The navigation pane can be opened by selecting Ctrl+F, then selecting "headings" in the search bar that opens. In the example below, all headings entered into the document with a heading style applied appear in this navigation pane. In the navigation pane, all left-aligned and caps-locked headings are 1st level, 2nd level headings are indented once, and 3rd level headings are indented twice. 
[image: A screenshot of a computer

Description automatically generated][image: ]
The ruler can assist with seeing margins and help determine if tables, figures, etc. are within the required margins. The gray area of the ruler indicates the margins. All images and text are required to be within the margins. Clicking on the tabs—as indicated by the circled areas—will reveal a line that helps to determine if content is within the margins. 
To enable the navigation pane and ruler:
1. Click on “View” in the toolbar 
2. Check the “Navigation Pane” and “Ruler” tabs.
[image: ]
Adjust any images, tables, and text that fall outside the margins. For accessibility purposes, even white space surrounding images must fall within the margins specified by the template. Additionally, images should be placed “in line” with text. To place images, objects, and text boxes in line, select the image, object, or text box. Then select Tools>Format>Position>In Line with Text.
After aligning the object, make sure to add “alt text” to your image, shape, chart, or SmartArt by right-clicking on the object and choosing “View” or “Format” “Alternative Text”. You can also choose “Alt Text” in the “Accessibility” section of the Format Picture panel. Add a title for your object, then a description.
[image: A screenshot of a computer
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[bookmark: _Toc207097739][bookmark: _Hlk158194467]Chapters
The templates have five chapters with placeholder titles. Replace the placeholder titles with new titles by deleting the placeholders and typing in the new titles. If needing more than five chapters, see Adding Chapters in Chapter IV for more details. 
Tables
Tables are required to fit within the margins detailed in Layout Requirements. Adjust the size and specifications or insert the table on a landscaped page if it is too wide for the portrait margins. See Landscape Pages for details on landscaping. 
Whenever possible, tables should be created using the table feature in Word using the information layout order left-to-right and top-to-bottom. The table should be placed “in line with text” so that assistive technology can access the contents. To do so, choose the “Insert” tab, then select “Table.” From the “Table” dropdown menu, select the appropriate number of columns and rows, and enter the desired table size. If the table fits better in a landscaped oriented page, you can landscape the page using the directions under “Landscaping a page.”
For accessibility purposes, all tables, charts, infographics, etc. that use color to symbolize meaning should provide text in addition to provide comparable information to users of assistive technology and people who are colorblind. In other words, these infographics must use text to duplicate the meaning of the color or visual characteristics (such as size, shape, and location). Any colors (not black and white) used in these infographics should also pass the Colour Contrast Analyser test. This test can be performed by opening the Colour Contrast Analyser, dragging the “Foreground eyedropper” icon over a sample of your text or image of text, and dragging the “Background eyedropper” icon over a sample of your background color.
As for table titles, the “Table Title” style will need to be applied for the purpose of building the List of Tables. See Chapter IV for more information on applying styles.
Insert Table continued headings if tables are longer than one page or are split between pages. If a table is too long to fit on one page, insert a table break to break the table into multiple sections. To do so, place your cursor in the bottom right cell, which opens the “Table Layout” tab. 
[image: A screenshot of a computer
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Select “Split Table.”
On the line that appears underneath the Table, Type “Table # (Continued).” Insert the table number where the # has been placed. Never write this heading inside a text box or inside of a table’s cell. Put your cursor to the left of this title, and insert a page break so the words move to the top of the next page. Apply the style “Table continued heading” or “normal” to this heading. Ensure your continued table appears as it should, including adding any heading rows as necessary. Note that if there is a table beginning at the bottom of a page and you would prefer that it start at the top of the next page so it all appears together, you may also insert a page break before the table title. See example below. 
Table 1
Table Example
	
	
	

	
	
	

	
	
	


Table 1 (Continued)
	
	
	

	
	
	

	
	
	

	
	
	


Table numbering will be different if using Template 3.
[bookmark: _Toc207097740]Figures, Schemes, and Musical Examples
Figures, schemes, and musical examples are required to fit within the margins specified in Layout Requirements. Adjust the size and specifications or insert image on a landscaped page if unable to fit them within the portrait margins. See Landscape Pages for details on landscaping.
[image: ]
Example of a Figure
Figure numbering will be different if using Template 3.
[image: ]
Scheme 1. Example of a Scheme
Scheme numbering will be different if using Template 3.
[image: ]
Musical Example 1. Example of a Musical Example
Musical Example numbering will be different if using Template 3.
	Figures, schemes, and musical example titles will need to have a style applied to them within the main text. See Chapter IV for more information on applying styles.
[bookmark: _Toc207097741]Footnotes
	The template does not restrict having footnotes in the document. Footnotes are one of the few exceptions to the 12 pt Times New Roman rule. Do not go below 8pt Times New Roman font.[footnoteRef:1] [1:  Here is an example of a footnote.] 

[bookmark: _Toc207097742][bookmark: Landscape_Pages]Landscape Pages
Landscape pages are ideal for tables, figures, etc. that do not fit within the portrait margins. Similar to portrait pages, the content of the landscape page must be within the margins. To view the landscape page margins, turn on the ruler function. See Navigation Pane and Ruler for how to turn on the Ruler.
Click here for a tutorial on how to landscape a page. See the next page for an example of a landscape page.
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Landscaped Page Example
Note: The image is aligned “in line with text” and the page number rotated and placed in the lefthand margin, per the landscape page tutorial. 
	13
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[bookmark: _Toc207097743]– PRELIMINARY PAGES, APPENDICES, AND REFERENCES
This chapter gives a brief overview of each template section and details which sections are required.
[bookmark: _Toc207097744]Title Page
	A title page is the first page of the template. All students are required to have a title and have it formatted as detailed by the guidelines below. A title page model is available on the Graduate School website as an example of the correct title page format.
Title 
· Type the title in the text box. The text box should automatically style titles in an inverted pyramid. 
· Title must be in 12 pt. Times New Roman all caps. 
· Title should not:
· Include bolded text
· End with a period (question marks are allowed)
· Contain special characters not found on a standard keyboard
· If the title requires a certain word or phrase to be italicized, remove the content control prior to italicizing the word(s). Right click on the title and select “remove content control.” 
· Only italicize the required words and phrases. Do not italicize the entire title.
· The first line of the title should be the first line at the top of the page. Adjust the spacing between the committee members’ names and the graduating month and year to move the title to the top.


Author Name
· Insert the name into the text box labeled "Author Name." 
· Verify that name matches (including use of middle name/initial) in all of these locations: SOAR, document title page, Aquila submission form’s author box, and Aquila submission Copyright box
· Do not include any prefixes (Mr, Mrs, Dr, etc.) or suffix credentials (PhD, EdD, MA, etc.) at the beginning or end of the name.
Document Type
· Use the drop-down menu to select whether the document is a dissertation, thesis, or doctoral project.
College, School, Degree
· Use the drop-down menus to select the College, School, and Degree. 
Committee Members
· Insert the names of all committee members under “Committee.” Verify with committee the names listed are accurate.
· The first name listed must be the committee chair. Please keep the comma and title "Committee Chair" after typing the name. 
· List the other members of the committee after the chair. The template has included some areas to insert the names of the committee members. Remove any extra "Name of Committee Member” tags. 
· If the committee member has a doctorate, give them the prefix "Dr." before the name. Do not add any suffix credentials after the name. 
· If the committee member does not have a doctorate, do not include a prefix, such as Mrs., Mr., Miss, etc. or any suffix credentials.
Graduating Month and Year
· The date on the title page and the Aquila submission form must reflect the graduating month and year. Do not put the defense date or the semester the document is completed. 
· Select the graduating month (May, August, or December) from the drop-down menu on the Aquila submission form and the Aquila title page. 
· Type in the graduating year next to the month. 
[bookmark: _Toc207097745]Copyright Page
	The Copyright Page is required even if the student does not anticipate filing for copyright. See Copyright under Chapter VI for more information about filing for copyright.
[bookmark: _Toc207097746]Abstract
	All students are required to have an abstract. For theses, the maximum word count is 250 words. For dissertations and doctoral projects, the maximum word count is 350 words. The page number will start with Roman numeral “ii.”
[bookmark: _Toc207097747]Acknowledgements
	A required section for your professional remarks (i.e. thanking the committee, advisor, any organizations that provided assistance, etc.). 
[bookmark: _Toc207097748]Dedication
	An optional section dedicated to personal remarks (i.e. thanking your parents, friends, and pets). Delete if opting out of using this section in the template. 
[bookmark: _Toc207097749][bookmark: Table_of_Contents]Table of Contents
	A required section in the document where chapter titles, headings, subheadings and their respective page numbers are listed. Do not type directly into this section or the Lists of Tables, Illustrations, Schemes, or Musical Examples. These Tables of Contents are updated by applying the appropriate heading style (1st level, 2nd level, 3rd level, or 4th level heading) to the headings within the main text. After applying the appropriate heading style to all headings, the Table of Contents will need to be updated. Chapter IV will cover how to apply styles and update the Table of Contents. 
[bookmark: _Toc207097750]List of Tables
A required section if the document contains tables. Remove this section if tables are not required. The List of Tables is built by applying the Table Title Style to the table titles within the main text. After applying the style to the table titles, the List of Tables will need to be updated similar to the Table of Contents. See Chapter IV for more details on applying styles and updating List. 
[bookmark: _Toc207097751]List of Illustrations
A required section if the document contains Figures. Remove this section if figures are not required. The List of Illustrations is built by applying the Figure Title Style to the figure titles within the main text. After applying the style to the figure titles, the List of Illustrations will need to be updated similar to the Table of Contents. See Chapter IV for more details on applying styles and updating List. 
[bookmark: _Toc207097752]List of Schemes
A required section if the document contains Schemes. Remove this section if schemes are not required. The List of Schemes is built by applying the Scheme Title Style to the table titles within the main text. After applying the style to the scheme titles, the List of Schemes will need to be updated similar to the Table of Contents. See Chapter IV for more details on applying styles and updating List. 
[bookmark: _Toc207097753]List of Musical Examples
A required section if the document contains Musical Examples. Remove this section if Musical Examples are not required. The List of Musical Examples is built by applying the Musical Example Title Style to the example titles within the main text. After applying the style to the example titles, the List of Musical Examples will need to be updated similar to the Table of Contents. See Chapter IV for more details on applying styles and updating List. 
[bookmark: _Toc207097754]List of Abbreviations
	An optional section available for students to list their abbreviations used throughout the text that indicates professional or scholarly terms, such as jargon, agencies, legislation, etc. Please remove this section if not planning to utilize it. 
	Unlike the previous sections, the List of Abbreviations does not populate based on any styles that are applied within the main text. Students will need to manually type in the abbreviations. The list should be centered (in two columns) in alphabetical order. 
[bookmark: _Toc207097755]Appendix
	There are two Appendix entries inserted into the template (Appendix A and Appendix B). Each Appendix entry will populate in the Table of Contents. The Graduate school does not require an Appendix unless students require IRB and/or IACUC approval. Official IRB and IACUC letters should be inserted into the appendix.
	Appendices often contain contact information. Make sure that you redact any personal identifying information (e.g. phone numbers, addresses, emails) before submitting your document for publication. 
If additional appendix entries are required, see Adding Appendix Entries in Chapter IV for more details. 
[bookmark: _Toc207097756]References
	All students are required to cite their sources and list their sources. References are the last section of the document if using Templates 1, 3, and 4. If using Template 2, the reference section heading is renamed Works Cited and follows the Introduction. Entries in the References section should follow the style manual that was decided by the committee. 
	Note: References can be renamed Bibliography, Works Cited, etc. in order to match the selected style guide. 
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[bookmark: _Toc207097757][bookmark: Chapter_3][bookmark: Chapter_4]CHAPTER IV– STYLES 
Styles are an important function for building the Table of Contents, List of Tables, List of Illustrations, List of Schemes, and List of Musical Examples. The style pane is located in the Home tab.
[image: A screenshot of a computer
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[bookmark: _Toc29373488][bookmark: _Toc207097758][bookmark: List_of_Styles]List of Styles
1st level heading: Used on 1st level headings. 
2nd level heading: Used on 2nd level headings. 
3rd level heading: Used on 3rd level headings. 
4th level heading: Used on 4th level headings.
Chapter Title (CT): Format for Chapter numbers. Clicking this style will generate “CHAPTER #” where # is the next available chapter number. Chapter titles follow the Chapter number heading as such: CHAPTER I – TITLE. 
Paragraphs: This is the default style for paragraphs. 
Scheme Title: Used on scheme titles (Template 3 & 4 only). 
Scheme Notes: A style for formatting notes for schemes (Template 3 & 4 only). 

Musical Example Title: Used on musical example titles (Template 4 only). 
Musical Example Notes: A style for formatting notes for musical examples (Template 4 only). 
Table Title: Used on table titles. 
Table Notes: A style for formatting notes for tables. 
Figure Title: Used on figure titles. 
Figure Notes: A style for formatting notes for figures. 
APPENDIX: Format for Appendix heading (at the top of the first page of each Appendix). Clicking this style will generate “APPENDIX $” where $ is the next available letter. 
AT: Used on table titles in the appendix. 
AF: Used on figure titles in the appendix 
New “chapter”: Used to format the heading/new page for a new poem or story. Note – Novelists should use the Chapter Title (CT) so that the chapters will be numbered and titled correctly. This appears only in Template 2.
[bookmark: _Toc207097759]How to Apply Styles
For headings to appear in the table of contents—or for tables, figures, schemes, or musical examples to populate in their respective list—the correct style will need to be applied to the headings or titles within the document. See the list in the previous section for the types of styles.


To apply a style to a heading, figure title, table title, etc:
1. Type out the heading or title and highlight it.  
[image: ]
2. Select the style by going to the styles pane in the home tab. Scroll through to locate the correct style. The red circle in the image on the next page shows where to scroll.
[image: ]
Another option for scrolling is to click the arrow in the corner of the styles pane.
[image: ]


After clicking on the arrow, a box with a list of styles will appear.
[image: ]
3. Once the appropriate style has been located, click on the style to apply it. A box will appear around the selected style, which indicates the style has been applied to the highlighted text.
[image: ]
[bookmark: _Toc207097760][bookmark: Removing_Styles]Removing Styles
	Styles applied to text that are not supposed to have styles will need to be removed; otherwise, the section or word(s) will populate in your Table of Contents, List of Table, List of Illustrations, etc. when updated. See How to Update the Table of Contents and Lists for more information on how to update. 


To remove a style: 
4. Highlight the word(s) that have a style applied.
5. After highlighting the section, go to the styles pane and scroll to find a style called “paragraph” or “normal” and select it. Once selected, the previous style will be removed.
[image: ]
Note: Do not right-click on highlighted style in the styles pane and select “remove style from gallery.” This will remove the style entirely from the pane rather than remove the style from the highlighted section. 
[bookmark: _Toc207097761]Adjusting Headings and Titles after Style Application
	The available styles come preformatted meaning when a style is applied the formatting automatically adjusts. Some of these preformatted styles do not comply with certain style guides. The formatting can be adjusted after a style has been applied to a heading or title
	Below is an example of a table title that is changed to having the title below the table number rather than having both on the same line. Also, the italics will be removed. 
The following example does not comply with any particular style guide. Also, table titles are not the only titles that can be adjusted. The format of headings, figure, scheme, and musical example titles can be changed as well.


1. Apply the proper style. In this case, the “Table Title” style was applied. 
[image: ]
2. [image: ]To get the table title on the next line, a soft return will need to be added by placing the cursor in front of the title and pressing (shift+enter). Do not do a hard return. A soft return guarantees the title will still populate in your List of Tables. 
3. Now that the title is separate from the table number, the italics can be removed by highlighting the italicized text and clicking on the “I” located in the “Font” section under the “Home Tab.” This will remove the italics.
[image: ]
[image: ]
	Note: Be consistent with the formatting of titles and headings throughout the entire document. 
[bookmark: _Toc207097762]Adjusting Table, Figure, Scheme, and Musical Example Title Numbers
	Tables, figures, schemes, and musical examples will automatically number when their respective styles are applied. In the event the automatic numbering is not properly numbering your tables, figures, etc., the number will have to be changed manually.
To change the number: 
1. Right-click on the number of the table, figure, etc. 
2. Select “Set Numbering Value” from the list of options.
[image: ]


3. Select the correct number by using the arrows on the side or typing in the box. 
[image: C:\Users\w488666\AppData\Local\Temp\SNAGHTML1c808a0.PNG]
4. Select “OK.” The table, figure, etc. will reflect the new number. 

How Many Dogs I Own
	German Shepherd
	1

	Labrador Retriever
	1

	Dachshund
	2

	Total
	4



Note: Sometimes, after setting the numbering value, the spacing of the table title might tab over. Fix the spacing if this occurs.
[bookmark: _Toc207097763][bookmark: Adding_Chapters]Adding Chapters
As mentioned in Chapter II, the templates come built with five chapters.
To add more chapters to the template: 
1. Create a section break (next page) to insert a blank page and create a new section (turn on paragraph marks to see section breaks). See Section Breaks for instructions on inserting section breaks. 
2. Type the chapter title on the first line of the blank page and highlight it.
3. Once the title is highlighted, go to the styles pane and select “Chapter Title.” If using Template 2, the style is called “New Chapter.”
[image: ]
4. After applying the “Chapter Title” style, the heading will have a chapter label and number. 
[image: ]
5. Insert an en-dash between the chapter number and the title. To insert an en-dash, hit Ctrl+Minus on your keyboard.
[image: ]
[bookmark: _Toc207097764][bookmark: Appendix_Entries]Adding Appendix Entries
To insert additional appendices:
1. Insert a section break (next page) to create a blank page after Appendix B. 
2. After the blank page is created, put the cursor on the first line and type in the title of the Appendix entry. 
3. Once the heading is typed, highlight the heading and go to the styles ribbon and click on APPENDIX. 
[image: ]
4. After applying the APPENDIX style, the title will have an appendix heading. 
[image: ]
5. Insert an en-dash between the Appendix letter and the title. To insert an en-dash, hit CTRL+MINUS on your keyboard.
[image: ]
[bookmark: _Toc207097765]Table, Figure, Scheme, Musical Example Title Label for Appendix
For tables, figures, schemes, and musical examples that appear in the appendix, one of the Appendix Styles will need to be applied to the heading instead of the standard Table, Figure, Scheme, and Musical Example styles. See List of Styles for the different types of Appendix Styles.
	Once the appropriate Appendix Style has been applied, the table, figure, etc. will have the label followed by the letter “A” and a number. For example, the first figure in the appendix will have the label “Figure A1” before the title. The only exception is Template 3 which will label tables, figures, and schemes based off the letter of the Appendix entry. For example, the first figure in Appendix B will be labeled “Figure B1.” 
[image: C:\Users\w488666\AppData\Local\Temp\SNAGHTML56ecee.PNG]
[bookmark: _Toc207097766][bookmark: Update_TOC]How to Update the Table of Contents and Lists
	Once a style has been to all headings, table titles, etc, the Table of Contents and Lists in the Preliminary pages will need to be updated. The instructions for updating these are different for PC and Mac Users. Below are instructions for how to update the Table of Contents. These instructions also apply to updating the List of Tables, List of Figures, List of Schemes, and List of Musical Examples.  
PC Users
1. Right-click on the Table of Contents. This will cause the TOC to turn gray and a box will appear.
2. In the box, there is an option to “Update Field.” 
[image: ]
3. After selecting “Update Field,” another box will ask whether to update the entire table or just the page numbers. Select “Update Entire Table” and click “OK.” The TOC will populate with the headings that have styles applied.
[image: C:\Users\w488666\AppData\Local\Temp\SNAGHTML1c0bc45.PNG]

MAC Users
1. Highlight the entire TOC
2. On the tool bar, click on “References”
3. Select “Update Table” and a box will appear that will ask whether to update just the page numbers or update the entire table. Select entire table. The TOC will populate with the headings that have styles applied.
After updating TOC, if headings are not populating, check the style of the headings within the main text to see if the appropriate heading style was applied. 
If there are words, phrases, paragraphs, etc.  appearing in the Table of Contents that should not be populating, check the text in the body of the document and confirm that no style has been applied. If the text is indicated as having a style applied to it, change the style to “normal” or “paragraph.” See Removing Styles for more details. 
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[bookmark: _Toc207097767]CHAPTER V– SUBMISSION AND REVIEW PROCESS
[bookmark: _Toc207097768]Aquila Submission
Once the document is uploaded to Aquila and all prior deadlines leading up to the submission are met, the Documents Specialist will review the format of the dissertation, thesis, or doctoral project and provide feedback. Turnaround time for review varies and increases as deadlines approach. The document will be reviewed as quickly as possible, and students will be contacted via their USM email as soon as the review is completed. 
The document should be formatted into one of the templates and all content and grammar, including committee revisions, must be polished before submitting to Aquila. No changes to the document’s content will be allowed once submitted. The only content changes that are allowed are those designated by the Documents Specialist. 
Even if you do not use MS Word’s proofing tools such as autocorrect, set the correct proofing language for your document. If you use more than one language in your document, make sure you change the applied proofing language for the appropriate sections. For example, if your dissertation is primarily in English but you include a Spanish-language poem in Appendix A and an Arabic-language questionnaire in Appendix B, the proofing languages should be set to English in the body of the document, Spanish in Appendix A, and Arabic in Appendix B. Press Ctrl+S or select File, then Save. Documents should be saved as .docx file type with a descriptive filename that includes your lastname.firstname_document type then date of submission. 
Students ought to give themselves a sufficient amount of time to complete all revisions and submit to Aquila. Failure to submit by the posted deadline will result in deferral of graduation to a future semester.


Submitting Document to Aquila
To begin the submission process:
1. Select the appropriate link:
· Dissertation: http://aquila.usm.edu/dissertations 
· Theses: http://aquila.usm.edu/masters_theses 
· Doctoral Project: http://aquila.usm.edu/dnp_capstone 
2. Click on “My Account” at the top left and create an account. Students should use their USM email to create the account. 
[image: ]
3. Check for the verification email that Aquila will send to confirm the account. Check the Spam/Junk box for the email.
4. After creating an account, click on “Submit Research” located under “Author’s Corner” on the left-hand side.
[image: ]
5. Fill out the submission form, upload the word document, and click “Submit.” See the next page for more information about how to complete each section of the form
6. Prior to submitting, confirm the information you provided on the form is correct and allow the submission to process before closing out the window. Closing the window out early might result in submission not being processed. 
7. Contact the Documents Specialist to confirm submission has been received. 
Submission Form
	The Submission Form will look similar to the image below. The next couple of pages will detail how to complete each section of the form.
[image: ]
Title: Enter the title as it appears on the title page of the dissertation, thesis, or doctoral project. Use Title/Headline capitalization as shown in the example on the next page. Do not use all caps or special characters not found on a standard keyboard. 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
Author: The name and email used to create the account will automatically populate in this box. 
Date of Award: Enter the graduating semester and year. 
Student’s Permanent Email: Student should put the email he or she can be reached after graduation. Please do not put down the USM email.  
Degree Name: Select a degree from the menu. Should match the degree on the title page.
School: Select the school from the menu. Should match the School on the title page. 
[image: A screenshot of a computer

AI-generated content may be incorrect.]
Embargo Period: An embargo withholds the release of a document. Students can set the embargo period in the Aquila submission form. See Embargo/Delaying Publication in Aquila for more details. 
Future Permission: Select one of the three options from the drop-down menu. Sometimes scholars will request to use part of a student’s document for their research, such as a survey. Choosing one of the three options determines how Aquila administrators should respond to these requests. 
Committee Chair and Committee Members: Type in the names of the committee and select their School in the boxes provided. Names should match what is on the title page. Do not select a School for committee members not affiliated with USM.
Keywords: Type up to six keywords or phrases separated by commas. The words and phrases help classify and make it easier for interested parties to locate the document. 
Subject Categories: Select subject categories that best fit the document. Choosing subject categories helps interested parties locate the document.
Abstract: Copy and paste the abstract from the document into the box provided. The word count cannot exceed 250 words for theses and 350 words for doctoral projects and dissertations.
ORCiD ID: It is optional to sign up to get an ORCiD ID. Visit the link provided on the submission form for more information. Leave blank if choosing not to obtain an id. 
[image: ]
Copyright: Enter your name as it appears on your title page, followed by a comma and then the year. 
[image: ]
Upload Full Text: Select “Upload file from your computer” and then click on “Choose File.” Select the appropriate file. Once the file has been selected, click on “open” and the file will be attached to the submission form.  
[image: ]
Additional Files: This section is optional. Contact the Documents Specialist to get approval to have additional files attached to the submission.


Open Access Statement and Submit: Check the box and click “submit” for the document to be submitted into Aquila. Before submitting, confirm the information on the form is correct. 
[image: ]
[bookmark: _Toc207097769]Document Review
	The Documents Specialist will review documents submitted via Aquila. Do not email the document to the Documents Specialist. Comments regarding revisions will be added to the Word document using Word’s comment function. If using Latex, and have to submit the document as a PDF, comments will be made using Adobe’s sticky note function. 
	After the Documents Specialist has reviewed the entirety of the document and added comments, the document with comments will be uploaded into Aquila. The Documents Specialist will also post a decision about the document: Accepted, Accepted with Minor Revisions, Major Revisions Required before Acceptance, and Reject Document. 
	An email from both Aquila and the Documents Specialist will be sent to the student’s USM email once the document has been uploaded and a decision has been registered. Students will need to log into Aquila to view the document with comments. Students will need to make the revision designated in the comments and upload the revised document to Aquila for the Documents Specialist review. 
To submit a revised document:
1. Login to your Aquila account and click on the title of the submission 
[image: ]
2. In the navigation bar on the left-hand side, click “Revise thesis,” “Revise dissertation,” or “Revise project.” The option selected will be based on the document type. 
[image: ]
3. The submission form that was completed upon the first submission will appear. Scroll down to “Upload Full Text” on this page and upload the revised document. [image: ]
4. Click “submit.” Allow the submission to process before closing out the window. 
5. Contact the Documents Specialist to confirm submission of the thesis, dissertation, or doctoral project. 
Note: The revision process might be repeated multiple times. All revisions will need to be completed and document will need to be accepted by the final submission deadline. 
[bookmark: _Toc207097770]Final Checklist
	Once the document has been accepted without further revisions, students should complete the final checklist located on the Graduate School website. The first item of the checklist is for students to inspect the final pdf converted in Aquila for conversion or formatting errors missed during the review. After inspecting, if there are no formatting changes, please move on to completing the other items on the checklist. 
Notify the Documents Specialist once all items are completed. The checklist will need to be completed no later than the final Aquila submission deadline. A confirmation email from the Documents Specialist will be sent to the student’s USM email once all requirements have been completed. 
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[bookmark: _Toc207097771]CHAPTER VI– PUBLICATION
[bookmark: _Toc207097772]Release in Aquila
	The final, Graduate School approved document will be publicly available in Aquila following commencement. Students completing during the summer semester will have their document released following the last day of classes.
[bookmark: _Toc207097773][bookmark: Embargo]Embargo / Delaying Publication in Aquila
	Though it is highly recommended students do not delay publication in Aquila, there are certain circumstances where restricting public availability is beneficial (e.g. waiting on a patent or another publication is pending). Publication can be delayed by placing an embargo on the document. An embargo can be placed on a document in the submission field in Aquila. Students can select any embargo period from a few months to over 150 years by typing the desired embargo period into the provided boxes. Students should discuss with their committee whether or not an embargo is ideal, and what period of time best suits their needs. 
[image: A screen shot of a computer

AI-generated content may be incorrect.]
The Graduate School is not responsible for processing or extending embargoes for any physical or electronic copies submitted to other databases or organizations. Students are responsible for contacting and following those databases and organizations embargo procedure.
	Once the embargo is processed, the document will not be available for public access via Aquila during the embargo period. For archive purposes, some of the document information provided on the Aquila Submission Form (i.e. title, author name, committee members, and abstract) can be openly viewed. However, the document will not be available for download until the embargo expires, and personal information (i.e. emails and phone numbers) will not be divulged. 
	In the future, if a student needs to extend their embargo in Aquila, the Documents Specialist will need to be contacted regarding the extension. It is recommended students begin the process of extending the document’s embargo well before it expires. The Documents Specialist and the Graduate School are not responsible if embargoes expire before the new embargo request is processed. 
[bookmark: _Toc207097774]ProQuest
The option to submit to ProQuest is available for both master’s and doctoral students. The Graduate School does not cover any of the fees or handle ProQuest submission on behalf of students. Contact ProQuest directly for any questions or concerns.
[bookmark: _Toc207097775]Bound Copies
	The Graduate School does not require a bound copy; however, certain programs may require students to submit a copy for their archives. If required, students are responsible for binding a copy according to their program’s specifications and delivering the copy to their program. Consult the academic unit to determine their bound copy policy.
Online binding services are available through Thesis on Demand and ProQuest. Students are not limited to these options and may select any online or traditional bindery for personal copies. 
The Graduate School is not affiliated with Thesis on Demand, ProQuest, or any other online or traditional bindery. Consult with the bindery directly regarding questions or issues with their services. 
[bookmark: _Toc207097776]Signature Page
	The Graduate School no longer requires students to submit a signed title page. Certain Schools and programs may require signed title pages for their records or bound copies. If required—or wanting a signed title for personal records and copies—a signed title page template is available on the Graduate School website here. Students are responsible for obtaining signatures.
Students can request the Documents Specialist review the signature page prior to collecting signatures. Allow five to ten business days for the Documents Specialist to review. 
[bookmark: _Toc207097777]Copyright
The United States Copyright Office defines copyright as "a form of protection grounded in the U.S. Constitution and granted by law for original works of authorship fixed in a tangible medium of expression. Copyright covers both published and unpublished works" (Retrieved from Copyright.gov). 
The Graduate School does not file for copyright on behalf of students or cover fees. Copyright can be filed directly with the U.S. Copyright office, or ProQuest offers services to file on behalf of students.
Check out the following links for more information on copyright:
University Libraries Copyright Basics 
U.S. Copyright Office 


[bookmark: _Toc207097778]NEED ASSISTANCE?
Contact the Documents Specialist for thesis, dissertation, or doctoral project related questions. The Documents Specialist can be reached via email at documentspecialist@usm.edu or by calling 601-266-4372. 
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